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Installation Instructions
We recommend installing the software on any PC that you can leave on while the software is
running. It will work on even an old PC that has Windows installed.
Download the EmailBotSetup.msi file.
If you are asked if you want to “Keep” or “Discard” the download, select “Keep”.
Double click the EmailBotSetup.msi file to begin the installation process.
A window appears like this:

Click on “Next >” to begin installation.
You will be asked to confirm the installation location, and which users can access the program. We
recommend accepting the default options:
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Click next again to confirm installation:

The installer will begin:

If you are prompted that an unknown program is trying to make changes to your computer, click on
Accept. The installer will continue:

Click on Close, and your software is ready to use.
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Opening the Email Marketing Robot
A shortcut has been placed in the Start Menu, so to run the Email Marketing Robot, click on your
Windows logo, then click on the Email Marketing Robot link. If you are using a newer version of
Windows, you will find the shortcut in your Apps folder.

Setting up your Email Marketing Robot
First of all let's go into “Options > Settings” to set up your Email Marketing Robot:

The Settings window looks like this:
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Emails per hour
Depending on your daily sending limit with your email server supplier, set the rate so that it does
not exceed your daily limit. For example, the daily sending limit with Gmail is 500 emails per day,
so if you run the software for 8 hours a day, your limit should not exceed 62 emails per hour.
If your email provider offers an unlimited service, you can set this limit at the maximum of 90
emails per hour.
If you find that when running the software you hit any daily sending limits, simply lower this speed.

SMTP server settings
Many of our customers use the free Gmail SMTP service to send emails. You can use any SMTP
server, including that provided by your internet service provider.
Often, you are able to copy the outgoing server settings from your email client software, such as
Outlook or Thunderbird.
If you are using Gmail the settings are as follows:
SMTP Server: smtp.gmail.com
Port: 587
SSL: Ticked
Username: Your @gmail.com email address
Password: Your gmail password
From Name: Enter your name here (no unusual characters)
From Email: Same as username
There are two additional settings with Gmail that need activating. Please log into your Gmail
account using your web browser.
When you have logged into Gmail click on the cog in the top right corner under your name, then
click on Settings:

When the settings page loads, click the option in the middle of the screen that says “Forwarding and
POP/IMAP”:
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Click the radio button to Enable POP for all mail, then scroll down and click on the “Save Changes”
button.
Whilst still logged into your Gmail account that you will be using with the Email Marketing Robot,
please visit the following URL:
https://www.google.com/settings/security/lesssecureapps

Please ensure that access for less secure apps is turned on by clicking the radio button as above.
That is it! Your Gmail account is now set up to work with the Email Marketing Robot.
If you are using another SMTP provider:
Please consult your provider's instructions, as every outgoing email server has different settings.
You need to get the settings exactly right for the software to be able to send emails.
If you need a commercial SMTP provider:
If your current provider does not allow sending hundreds of emails per day, and you don't wish to
use Gmail, you can use a commercial SMTP provider.
We have providers listed at http://www.emailmarketingrobot.com/smtp/ who are aware of our
software, and provide servers suitable for sending cold outreach emails.

Email Sending
We recommend that you untick the option that says “If no email address is found use defaults”.
It is best to send emails only to businesses who have an email address on their website.
Guessing email addresses when one is not found will result in a lot of bounced back emails.

Test Mode
Enter any other email address here that you have access to, other than the email address that the
software sends from. This then allows you to test campaigns to see what the email will look like
when received by companies that you are sending to. More about this in a later chapter.
You can click the “Send Test Email” button at this time to verify that your above settings are
correct. If you get any error please check your settings.

For SEO purposes skip first __ pages
If you are using the software to contact businesses who are not on the first page of Google, you can
set the software to skip the first page of results by setting this to 1.
If you are not using the software to promote SEO services, please leave this setting on 0.
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Email Search Threads
This is how many websites the software will search for email addresses simultaneously. On a fast
computer set this as 10. If your computer is slower decrease this setting, and the software will use
less memory. On an old PC we recommend setting the search threads to 2.

Scheduling Your Robot
The next step in setup is to schedule when your Email Marketing Robot should run. To do this, click
Options, then Email Schedule:

The next screen you see appears like this:

You now have the ability to set start times, end times, and any days off.
If you want the Robot to run on a particular day, check the tick box. If you don't want it to run that
day, untick the box.
Then you can set the start time in the first column, and the end time in the second column.
If you want the Robot to run 24 hours that day, simply enter 00:00 to 23:59.
When you are done, click the “Save” button.
You also have the option to have the Robot run continuously, or follow the schedule. You can
change this setting by clicking “Scheduling” in the main menu, then selecting the desired option:
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SMS Options
The Robot can also send text messages to UK mobile numbers, if one is found. We partnered up
with an SMS provider called VoodooSMS who can sell you credits if you wish to use this option.
To configure SMS sending, click “Options > SMS Settings”:

You will see a window like this:

To enable SMS sending, you will need to buy some credits, so click the link to create your account
and buy credits. You can then enter your VoodooSMS username and password in, and click the
Refresh balance link to verify that your account is connected. It will show how many credits that
you have remaining in your account.
If you wish to send text messages, click on the tick box labelled “Send SMS if UK mobile number
is found”.
You then have the following choices in the dropdown menu:

So, if you tick the box, and a mobile number is found the software will either not send an email, or
it will also send an email message – depending on your preference.

Page 8

In the message box you can send up to a 160 character text message. Please note that the special
tags (explained in a later chapter) are not available in this box. The message will be sent out as
written in this box.
You can include a web link or phone number that will become clickable on the recipients device.
When you are happy with your SMS options, click “Save”.

Blacklists
The Robot has several blacklists it uses to avoid certain email addresses, and domain names that
you specify.
To access the Blacklists, click on the “Blacklists” option in the main menu:

Email Blacklist
Here you can copy and paste a list of email addresses into the Robot, to ensure that the Robot will
not email those addresses.
For example, you can copy and paste in a list of your current client emails, this will help to ensure
that they are not contacted by the software, and prevents current customers from seeing offers that
you are aiming at new customers only.

Simply enter each email address on a new line.

SMS Blacklist
If you are using the SMS option and someone asks to opt out, simply enter their mobile number on
a new line, in the format 447XXXXXXXXX. Don't start the number with a + sign, or 07.
Again, enter each mobile number on a new line.

Domain Blacklist
This is the blacklist that we recommend using for any unsubscribe/do not contact again requests. To
prevent the Robot from emailing the company again, enter their domain name on a new line.
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You can also use the Domain Blacklist to prevent the software from contacting any common
directory websites that appear in search results for your target areas.
Enter each domain name on a new line:

Domain Filter
Often there are many websites that match certain patterns that you may wish the Robot to avoid,
and for these websites you can use the Domain Filter.

The Domain Filter accepts the * character as a wildcard, so you can exlude all domains that end
.ac.uk by adding *.ac.uk on a new line. You can also avoid all .EDU domains by adding *.edu.
You can also exclude domains containing a word such as “job” by adding *job*. This will make the
Robot avoid all job sites.
If you see certain websites coming up that have a lot of variations, you can use the Domain Filter to
exclude those. For example there are a lot of different TripAdvisor domains. You can exclude them
all by adding *.tripadvisor.* on a new line.
You can also exclude country domains by adding entries such as *.ie and *.au to avoid those
countries, which is useful if your targeting is picking up any foreign websites by accident.
When you are happy you can click “Save”. You can always make changes to these filters at any
time, for example if you notice any undesirable websites appearing in the search results.
So now your Robot is all set up, let's walk through the next step.
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Starting a New Campaign
The first step starts by starting a new campaign file.
We recommend that you make a list of your target business types in a plain text file, using Notepad,
and save this for reuse later if you decide to contact those same company types but in a different
area geographically.
Also, make a list of your target place names in a text file, again using Notepad. I highly recommend
that for accurate targeting you put the place names in as Town County, each on a new line.
So let's look at how to put this information into the Robot. First click on “File”, then “New
Campaign”:

When you click “New Campaign”, a screen will appear to enter the campaign details, like this:

Here you can load from file your list of business types, and list of geographic targets. Or, you can
type them straight into the software if you wish.
The following links are useful for this section:
Complete list of UK towns and cities:
http://www.emailmarketingrobot.com/towns-and-cities/united-kingdom/
Lists of business categories, including full list:
http://www.emailmarketingrobot.com/getting-started/business-targeting/

Clear list of send email addresses/mobile numbers
This option, if ticked, will cause the Robot to forget all the email addresses and mobile numbers
that it has sent to in the past. So that if it finds those websites again, they will be emailed or texted
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again. Only tick this option if you want to send a second email to any contacts.
By default the Robot will only email each domain once, to minimise any spam complaints.

Do Strict Searching
This option makes the Robot more accurate when it comes to business categories. For example, if
you have a business category of IT consultant, without this option ticked the software could pick up
all types of consultants – because the word IT is also a very common word in English.
By ticking “Do Strict Searching” the Robot will only look for websites where the words IT and
Consultant are next to each other, so it should pick up more “IT consultants”, and less other types of
consultants.
Use strict search if the company type is more essential, without it the software will also find more
broad matches.
When you are happy with your campaign setup, click “Save”.
Give the campaign a name that you will remember, and click Save again:

This enables you to run multiple campaigns with the Robot. For example, you can run this
campaign today, then start another campaign tomorrow, then the next day you can come back to this
campaign again and it will start where it left off.
Now the campaign is saved, the next thing to do is to set the Region and Depth:

Set the “Region” to match the country that you are targeting. If the country that you are targeting is
not listed, please contact us and we will add that country for you.
Set the “Depth” to the number of pages the Robot will effectively search on Google to find
matching websites.
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The deeper the depth setting, the more results the Robot will find, but the less accurate the results
may become towards the end.
You should set the depth at a setting where you are getting a good number of results, at the accuracy
level that you desire.
As a rule of thumb, 5 pages deep works for most searches.

Subject Line
The subject line is the most important part of your cold outreach email marketing campaign, and
there are many books devoted to this subject.
We recommend that you brainstorm a list of 100 subject lines for your email, then pick out the top
five that you think will lead recipients to open your email.
The email subject line should not be misleading, but should provoke enough curiosity for the
recipient to want to read the email.
It is a good idea to think about the end result of what you are offering, and put that as the subject
line. For example, if we are inviting local business owners to a networking event, the end result of
that could be referrals, so the subject line “Referrals” could work well.
You can have the software test headlines for you by using this format:
{option 1|option 2|option 3|option 4|option 5}
Start with the curly bracket, and separate each subject line with the divider symbol. The Robot will
pick a subject line at random, and by monitoring replies you can figure out which subject line is the
most effective.

Body Text
Again, there are many books written on cold outreach business to business email marketing. The
aim of your first message should be to make it as easy as possible for prospects to say yes, thereby
generating a lead that you can follow up on. Don't try to make the sale in the first message.
It is a good idea to offer something for free, such as a free info pack, brochure, or quote. Event
invitations also work particularly well.
To edit the body text, you can either enter it directly in plain text in the larger box under the subject
line, or you can click the “Rich Text Editor” button to edit the more powerful rich text editor:
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Special Tags
The software supports various special tags, that insert certain information into the email
automatically:
#greeting#

This will insert “Good morning”, “Good afternoon”, or “Good
evening”, depending on your computer time.

#companytype#

This will insert the current company type the Robot is working on,
useful for personalising their email.

#CompanyType#

This will insert the company type in Title Case, rather than lower case.

#location#

This inserts the current location the Robot is working on. Since we
recommend that you add locations as Town County, we do not
recommend using the #location# tag in your emails, as Town County
does not sound natural.

#Location#

This inserts the location in Title Case, instead of lower case.

#position site found in#

For SEO purposes this will show the position in Google that their
website was found in. For example, position 21 means that they were
the first result on the 3rd page, as there are 10 results on each page.

For most users, we recommend that you use the #greeting# tag, and #CompanyType# tag.
The rich text editor also allows you to format your email message to make it look more attractive.
Setting the type face
Select your text by clicking and dragging to highlight the text section, then click on the Edit Font
button at the bottom of the Rich Text editor:

The Edit Font button is the “ABC” button to the right of the Italic button.
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Select a font that looks attractive, then click on “Apply”.
You can also apply text styles such as Bold, Centred, and increase the font size:

The Bold button is the bold B at the bottom right of the menu bar, the font size button is the AZ
with up arrow button, and the centre text button is the image of centred text.
You can also adjust font colour, indent text, make bullet points, add a seperator line, insert a table
(grid), insert images, hyperlinks, find and replace text, and print the email out, all from within the
Rich Text Editor.
Adding images
We recommend keeping the use of images to a minimum, as they are not displayed by default.
When people receive an email from you, and you are not already in their Address Book, they will be
asked to “Show Images” if they wish the images to display.
Ensure that your email is not reliant on the use of images.
A good place to put an image is at the end of your email in the signature. This can help with
branding.
For example, if we want to add a small icon of the Email Marketing Robot, first position the cursor
by clicking where you want the image to appear, then click on the Add Image button:
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A dialogue box appears like this:

Your image needs to be hosted on the internet somewhere. If you need to upload your image from
your computer, the easiest service we have found for this is www.imgur.com
Then grab the link to your image, which should end .jpg, .gif, or .png, and paste it into the box that
says Href:
Add some alternative text in the Text: area such as “Click Show Images to see this image!”.
Next, select the alignment of your image with the next, and click “Insert Image”.
Finally, you can manually click and drag the image to the right place in your email, and use the
controls on the corners of the image to resize it to the correct size. It is best if you get it to the
approximate best size before uploading it, rather than relying on resize in the Rich Text editor.

When you are happy with your email message, click on the “Save” button on the bottom right of the
Rich Text Editor.
When you click Save, note that what appears in the top box is gibberish to anyone other than a web
developer, but when it displays in the email client it will look exactly like what appeared before in
the rich text editor.

You can go back and make changes at any time to your email by clicking the Rich Text Editor
button again, as long as the Robot is not running.
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Test Mode
When you are satisfied with your email content, it is important to test the campaign. Do this every
time that you start a new campaign.
Click on the “Mode” menu at the top, then select “Test Mode”:

The Robot will show Mode: Test at the bottom of the screen in the status bar, so you will know that
when you press the “Start” button, any emails sent will go to the test email address that you set up
in settings, and not to the companies email addresses.
Next, click on the “Start” button:

The Robot will now start finding websites for the first business type and location specified, and
matching websites will appear in the middle pane of the software:

After a few seconds, the websites that have been found will appear in the bottom pane of the
software, and the Robot will then start searching for contact email addresses on those websites:

When an email address is found, provided that the schedule is currently set to Send, then a test
email will be sent:

Page 17

Note that you can see “Test mode: Sent” in the Outcome column. Emails sent will stay on 0 in the
counter in the status bar, as only emails sent using Normal mode are counted here.
As soon as you see “Sent” in the Outcome column, you can click Stop:

Now, check your emails for the email that will have been sent to your test email address set up in
Settings earlier. Check that the email has come through correctly, and that all the #greeting#, and
#CompanyType# tags have been replaced properly.
If you see any error appear in the Outcome column, please go back and thoroughly check your
SMTP server settings.
When you are happy with your email message, put the Robot into Normal mode:

Then you can click “Start” again to start the Robot sending for real. It will start at the top of the list
again, so it will not miss any emails that were used during Test mode.
Loading and Saving Campaigns
You can switch between campaigns at any time, very easily, using the File menu.
To save the current campaign, click Stop on the Robot, then go to “File” > “Save Campaign”. The
campaign is now saved, and can be resumed at the current point.
You can now start a new campaign, or load a previously saved campaign. To load an existing
campaign, click “File”, then “Load Campaign”.
You will be prompted for the file location, click the campaign file you wish to load, then click the
“Open” button.
You will be asked if you wish to Resume or Restart the campaign:

Resume will start where it left off, whereas Restart will start again from the beginning.
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Export to CSV
You can export all of the data in the current campaign to a comma seperated values file (CSV file),
that you can then import into Microsoft Excel or other reporting software:

We do not recommend that you attempt to add all the found email addresses to a mailing list or
auto-responder. Only add those businesses that express an interest in your offer.
View Email History
You can view all the emails that have been found, and optionally clear the email history if you
would like the Robot to forget which businesses it has already emailed, this enables you to
periodically email the same businesses again.
Just click on “View”, then “Email History”:

You can also view the SMS History in the same way, if you are using the SMS option.
View Session Log
This option shows you a history of the Robot activities, and is useful for trouble shooting purposes.
View Registration Details
This menu is used when unlocking your Email Marketing Robot software.
The software will provide you with a unique “Key Code”.
We will provide you with a matching “Unlock Code” to copy and paste into the software.
Click on the “Register” button, and your software is unlocked.
Registering your Robot removes the “Powered by the Email Marketing Robot” message from the
footer of your outgoing emails, and removes the campaign limits of the trial version, giving you full
use of the software.
A range of licensing options are available to suit every budget.
Please see this page for full details:
http://www.emailmarketingrobot.com/register/
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Auto Select Processing
This is a new feature that will automatically select the line in the middle pane that the Robot is
working on, and the results will automatically appear in the bottom pane.
If you untick this option, you will need to manually click the line that the Robot is working on to
see the results.

We recommend that you have this option ticked.
Blacklisting Websites While The Robot Is Running
If you are watching the Robot while it is running, and see an unwanted website appear in the search
results (middle pane), you can right click that website, and blacklist the domain while the Robot is
running:

We recommend that you use the option “Add domain to domain blacklist”. This will ensure that the
Robot never searches, or emails that domain in the future.
About
If you go to “Help” then “About”, you will see this screen:

This shows the current version number, and the total number of emails sent.
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If you wish to remove the speed limiter (not recommended unless you are using an unlimited
commercial SMTP server), you can type the word FASTER while this screen is open, and the speed
limit will effectively be turned off.
If you close the software, then open it again, the speed limit will be turned on again.
Further Help and Advice
If you need any further help, please consult our frequently asked questions page:
http://www.emailmarketingrobot.com/faq/
If your question is not answered there, please contact us at:
http://www.emailmarketingrobot.com/contact/
You can also contact us via Twitter at:
https://twitter.com/androidmktng

Thank you for reading. Please let us know how you get on with the software!
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